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CDK?2000 Clocking Device Development Platform

Features

4 Modular Design

Motherboard/Daughter Card Design Allows
Flexible Use and Evaluation of All Members of
the CS2000 Device Family

<&

Software and Hardware Control

USB Connector for Use with CDK2000
Configuration Wizard Windows® PC-based
Software

Dip Switches for Stand-Alone Control in
Hardware Mode

<&

Dual Clock Inputs

Industry Standard BNC Connectors for
REF_CLK and CLK_IN with Input Buffers

<&

Dual Clock Outputs

Industry Standard BNC Connectors for
CLK_OUT and AUX_OUT with Output Buffers

¢ USB Powered

Evaluation Platform is Entirely USB-Powered;
No Separate Power Supply Necessary

Onboard Boost Converter Generates
Programming Voltage

Description

The CDK2000 ia a flexible modular development plat-
form designed to allow evaluation of all members of the
CS2000 clocking device family, including all members
of the CS2000, CS2100, CS2200, and CS2300 device
sub-families. For one-time programmable (OTP) parts,
the CDK2000 platform also allows for the development,
test, and production programming of custom device
configurations.

The on-board firmware handles all aspects of program-
ming the DUT and transitioning it between modes.
Furthermore, the CDK2000 Configuration Wizard soft-
ware is available for real-time control of DUTSs that can
run in Control Port mode.
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1. DEVELOPMENT PLATFORM OVERVIEW

11

Hardware Components

The CDK2000 clocking device development platform hardware components consist of a motherboard and
a number of individual daughter cards that, when connected, make a complete development system.

The CDB2000-MB is the motherboard of the development system. This board houses all clock I/O connec-
tors, control switches, power supplies, and PC interface hardware. Two single-row sockets are provided for
connections to any of the available daughter cards. The motherboard facilitates PC assisted development
and evaluation, as well as stand-alone production environment programming capabilities.

The CDB2000-PC represents a family of socketed daughter cards for use with the CDB2000-MB mother-
board. Each daughter card features an open-top push-down socket to quickly insert and remove DUTSs at
will, and is suitable for programming and testing multiple DUTs in a production environment. The CDB2000-
PC family daughter cards are capable of supporting both control port and one-time-programmable devices.
Two population options are available, each designed to support a specific frequency reference source for
the DUT.

Daughter Card Frequency Reference Source Sub-Family Devices Supported
CDB2000-PC-CLK Oscillator or BNC connector on motherboard. CS2000, CS2100, CS2200
CDB2300-PC-LCO Internal LC oscillator. CS2300

Table 1. CDB2000-PC Family Daughter Cards

The CDB2000-PC-CLK can be easily modified to support an on-card crystal as the REF_CLK source. A few
population changes are all that is required. See the CDB2000-PC Schematics in Figure 18 on page 24 for
population change details.

The CDB2000-DC represents a family of soldered-down device daughter cards for use with the CDB2000-
MB. Each daughter card features a soldered-down DUT for optimal performance and is most suitable for
prototyping and performance evaluation. The CDB2000-DC family daughter cards are capable of support-
ing both control port and one-time-programmable devices. Two population options are available, each with
a specific CS2000 family device soldered-down, and each designed to support a specific frequency refer-
ence source for the DUT.

Daughter Card Frequency Reference Source Sub-Family Devices Supported
CDB2000-DC-CLK Oscillator or BNC connector on motherboard. CS2000, CS2100, CS2200
CDB2300-DC-LCO Internal LC oscillator. CS2300

Table 2. CDB2000-DC Family Daughter Cards

The CDB2000-DC-CLK can be easily modified to support an on-card crystal or oscillator as the REF_CLK
source. A few population changes are all that is required. See the CDB2000-DC Schematics in Figure 12
on page 22 for population change details.

The complete ordering number of a CDB2000-DC daughter card will indicate the specific device soldered-
down by substituting the soldered-down device number in place of ‘2000’ and appending either -CP’ for
control port device, or *-OTP’ for a one-time programmable device. For example, a CDB2000-DC-CLK with
a CS2100-CP soldered-down would be ordered as CDB2100-DC-CLK-CP.

Development kits best suited for evaluation of particular sub-family devices are available; each contains one
motherboard and various combinations of the most appropriate daughter cards. See “Ordering Information”
on page 26 for complete details of the available kits.
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1.2 Software Components

The CDK2000 software tools, known as ‘Configuration Wizard’, facilitate the virtual configuration and hard-
ware control of any CS2000 family device, including all devices in the CS2100, CS2200, and CS2300 sub-
families.

The CS2000 Family Configuration Wizard is available for download from the CS2000 family product pages
on http://www.cirrus.com. This software tool presents an intuitive user interface to all configuration options
of the CS2000 family devices. The software offers two modes of operation: Demo mode and Live mode.

The Wizard will start up in demonstration (Demo) mode regardless of the presence of USB connection to a
CDK2000 (Noted by the text “CS2000 Wizard is running in DEMO Mode” in the bottom left and “DISCON-
NECTED” in the menu bar). In Demo mode the different devices in the CS2000 family may be selected from
the ‘Device Select’ menu. Once the desired device is selected, changes can be made to the GUI which cor-
respond to the selectable configuration options of the selected device. Demo mode is exited by selecting
‘Connect to CDK2000’ from the ‘CDK Controls’ menu.

A screen capture of the Configuration Wizard in Demo Mode is shown below.

-,

€52000-CP Configuration Wizard (DISCONNECTED) =
File CDK Controls Device Select  Tools  Help
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Fatio 0 Left-shift R-value by 0 (< 1) [

AUX_OUT SOURCE
REF _CLK

AUX_OUT

| Farm Entry [ Graphic Entry

!

LOCK CLOCK
| AF FractionakN |
m » Freq y Divider » thesi -
REF_CLK Nl il L__Tffff{ffi_jgfﬁ_J ' CLK_ouT
v || Pin7

Dirvicle by 4

GITAL FLL BANDWIDTH

FRACTIONAL-N VALUE

CLK_IN

(=]

PLL_CLK

B o200 Winardis mming i DEWO Mooe |G e N R

Figure 1. CS2000 Family Configuration Wizard, CS2000-CP Device Selected in Demo Mode
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The Wizard offers a calculator tool located in “Tools -> Calculator”. This allows easily calculation of ratio
values based off of desired input and output frequencies. The Calculator can be re-configured to solve for
output or input frequency when given a specific ratio using the radio buttons at the left. A screen capture of
the Calculator is shown below.

. |
Comm Link establishad with the COK2000. PLLLock Siatus | FsDetf1:0f Statis | Read Reg. | 00h | [ whiteValue [ 00h |
e v CLE_IM Fre Output Freq. [MHz] Fiatio Pl
" Reference Freq - [ i 0.00000000000000000000 El: 12.200
" Output Freg - I | 0.00000000000000000000 E|; 12.20
i+ Ratio - | | 0.00000000000000000000 == 12.20
0.00000000000000000000 ] 1220
Apply | Clear | No Limit or Bange checkingisperformedi Check with the Dala Sheet

Figure 2. Calculator Tool

The interface for a One-Time-Programmable device is slightly different. The maroon/dark red drop down
menus correspond to the Modal Configuration Parameters (see the CS2x00-OTP datasheet for details). The
“Mode Select” drop down at the top allows simulation of the M1:0 pins as well as configuration of the 4 modal
configuration sets. The M2 Low/High button simulates the usage of the M2 pin. The bright red drop down
selects the M2 global config parameter and the associated control will be outlined in red. A screen capture
of the Configuration Wizard configured for -OTP is shown below.

€52000-0TP Configuration Wizard (DISCONNECTED) =
File CDK Controls Device Select  Tools  Help
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GEITAL PLL BANDWIDTH
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a
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| J‘ PLL_CLK

0 52000 wizarsis running o DEwo wooe— |G R T N7

Figure 3. CS2000 Family Configuration Wizard, CS2000-OTP Device Selected in Demo Mode
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Alternately the form entry mode can be used to evaluate the -OTP when referencing the form found in the
CS2x00-OTP family datasheet. This also allows the view of all 4 modal configuration sets at once for quicker
setup and for verification of settings. A screen capture of the Configuration Wizard configured for -OTP is
shown below.

€$2000-0TP Configuration Wizard M [=!
File CDK Controls Dewice Select  Tools Help

Ratio 0 [dec) 0
Fiatio 0 (hes] o [ o J o [ @

|--BModSell:0-——] = E FracNSic
Mode 0 Cfg i] i] a a I 1]

Graphic Entry

Ratio 1 [dec) i]
Ratiotthen) || 0 ] |

|-—BModSell:0-—| = = FracHSic
Mode 1 Cfg i] i] ] a a ] i] ] i] a 1]

Ratio 2 [dec] 0
Riatin 2 (hex] o | o | oo | 0
|—-BModSel1:0-——] | -AuzOutSicl:0-—-| AutoRMod FracHSic

Mode 2 Cig

Ratio 3 [dec)
Ratio 3 [hex]

|-—-BModSell:0--—-] |---Aux0utSrcl:0---] AutoRMod FracHSic
Mode 3 Crg 1] 1] 1] 1] 1]

CIkSkipEn AuxlockClg |---RefClkDiv1:0--—| ClkOutlinl LFRatioCfg |
0 [ | 0 [ 0 |

0 52000 irorsis g e ooe— I S = L I

Figure 4. CS2000 Family Configuration Wizard, CS2000-OTP Device Selected in Form Entry Mode
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2. QUICK-START GUIDE

2.1 Software Installation

lInstalling the CS2000 Family Configuration Wizard Software

1. Browse to http://www.cirrus.com and navigate to a CS2000 family product page.

2. Click the “CS2000 Family Configuration Wizard” link under the “Tools and Software” heading. A page
containing the software licensing agreement will be loaded.

3. Click “Agree” to begin the download process. Allow the download to complete.

Unzip the package and launch the installer to begin the installation process.

5. Click “Finish” to complete the installation process.

2.2  Control Port Device Evaluation

1. Connect a CDB2000-DC or CDB2000-PC family board to a CDB2000-MB.

2. Ensure that an appropriate CS2000 family control port (-CP) device is soldered to the CDB2000-DC
family board, or insert an appropriate CS2000 family control port (-CP) device into the socket on the
CDB2000-PC family board.

3. Connect your PC’s USB port to the CDB2000-MB.

4. Launch the CS2000 Family Configuration Wizard.

5. Using the “CDK Controls” menu, select “Connect to CDK2000".

6. Click “yes” to establish a connection with the board; Then press “OK” on the USBXpress success mes-
sage.

7. If the device in the socket does not match the current GUI configuration you will get the “Warning! De-
vice mismatch!” message. Click “Yes” to allow the GUI to configure itself according to the device found
on the CDK2000. If this is not the device you intended to evaluate then click “No” which powers down
the device and you may then change the daughter card to the appropriate device.

8. Use the graphical user interface to define the device’s operation. Alternatively, choose “File -> Load
Configuration” to load a pre-configured device configuration.

9. Registers may be manipulated using the “Read Register” and “Write Register” buttons in the bottom
right of the window.

10. To power-off the evaluation platform, simply close the Wizard application and remove the USB cable
from the CDB2000-MB.

2.3 One-Time-Programmable Device Evaluation and Programming

OTP devices are shipped from the factory un-programmed. The device settings can be evaluated prior to

programming by the use of Preview Mode (see “Programming -OTP Devices” on page 13). Once evaluated,

the devices can be programmed with the CDK in one of two modes: Development and Production. Devel-
opment mode provides a variety of debugging options, while Production Mode allows for faster program-
ming cycle times. See “Development and Production Modes” on page 13 for more information.

2.3.1 Device Evaluation

1. Connect a CDB2000-DC or CDB2000-PC family board to a CDB2000-MB.

2. Ensure that an appropriate CS2000 family one-time-programmable (-OTP) device is soldered to the
CDB2000-DC family board, or insert an appropriate CS2000 family one-time-programmable (-OTP)
device into the socket on the CDB2000-PC family board.

3. Connect your PC’'s USB port to the CDB2000-MB.

8 DS821DB1
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10.
11.

N

13.

14.

15.

Launch the CS2000 Family Configuration Wizard.
Using the “CDK Controls” menu, select “Connect to CDK2000".

Click “yes” to establish a connection with the board; Then press “OK” on the USBXpress success
message.

If the device in the socket does not match the current GUI configuration you will get the “Warning!
Device mismatch!” message. Click “Yes” to allow the GUI to configure itself according to the device
on the CDK2000. If this is not the device you intended to evaluate then click “No” which powers down
the device and you may then change the daughter card to the appropriate device.

Use the graphical user interface to define the device’s operation. Alternatively, choose “File -> Load
Configuration” to load a pre-configured device configuration.

Note: The settings will not yet be programmed into the one-time-programmable memory. The Wizard
presents the user with a graphical controls over an internal virtual representation of the M2, M1, and
MO pins. The purpose of these controls is to facilitate the evaluation of the device’s currently
previewed configuration. These graphical controls can be toggled, and the device will respond exactly
as it will once the configuration is programmed into one-time-programmable memory and the M2, M1,
and MO pins are toggled.

Evaluate the current configuration by toggling the state of the “Mode Select” drop down and by
pressing the M2 Low/High button, checking the device’s functionality for the desired response.

Repeat steps 8- 9 until the desired configuration is achieved.

Once the desired configuration is achieved select “CDK Controls -> Write Preview Data to MCU..."
from the Wizard to save the current configuration to memory within the microcontroller on the
CDB2000-MB

This step downloads the current configuration into Flash memory within the microcontroller. Once this
step is complete, a one-time-programmable memory programming sequence can be initiated by
either software control through the Wizard or hardware control through a push-button on the
CDB2000-MB.

.3.2 Device Programming - Development Mode
12.

To program the one-time-programmable memory in the CS2000 family device using the Wizard
software, select “CDK Controls -> Initiate OTP Sequence...”.

To program the one-time-programmable memory in the CS2000 family device using the hardware
controls on the CDB2000-MB
a) Close the Wizard software.

The following steps reference the CDB2000-MB hardware.
b) Verify that D9 is lit, indicating that the CS2000 family device is in hardware mode.
c) Place DIP switch position 5 into the upper (or opened) position to select Development mode.
d) Press and hold the on-board push-button (S1) for more than 1 second to program the OTP
memory.

After the programming sequence is complete, the CS2000 family device will be able to operate in
hardware mode as defined by the programmed configuration. Simply ensure that the CDK2000
Configuration Wizard application is closed, and verify that D9 is lit indicating that the CS2000 family
device is in hardware mode. The M2, M1, and MO switches on the CDB2000-MB will control its
operation.

To power-off the evaluation platform, ensure that the CDK2000 Configuration Wizard application is
closed and remove the USB cable from the CDB2000-MB.

DS821DB1
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2.3.3

Device Programming - Production Mode

12. To program the one-time-programmable memory in the CS2000 family device using the Wizard
software, select “CDK Controls -> Initiate OTP Sequence...”.

13. To program the one-time-programmable memory in the CS2000 family device using the hardware
controls on the CDB2000-MB
a) Close the Wizard software.
The following steps reference the CDB2000-MB hardware.
b) Verify that D9 is lit, indicating that the CS2000 family device is in hardware mode.
c) Place DIP switch position 5 into the lower (or closed) position to select production mode.
d) Press and hold the on-board push-button (S1) for more than 1 second to program the OTP
memory.

14. After the programming sequence is complete, the CS2000 family device will be powered down
(indicated by D3 “VDUT” LED off) so that the device can be removed from the socket and the next
blank part can be inserted.

15. Insert the next blank part into the socket.
16. Briefly press the push button S1 to power up the device
17. Repeat steps 13d -16 (of Section 2.3.3) until the desired number of parts are programmed.

3. HARDWARE SYSTEM OVERVIEW

3.1

3.2

Power Supply

The entire CDK2000 platform is powered via the USB connector from a self-powered USB hub, which pro-
vides a voltage between 4.75 and 5.25 V. Other USB compliant power supplies, such as an AC (wall) adapt-
er or a DC (car) adapter, may be used as well. Whenever a suitable USB power supply is connected, D13
will be lit to indicate such.

A fixed voltage regulator (U10) provides the 3.3 V supply for the micro-controller, status LEDs, and three of
the four clock buffers.

An integrated Zetex™ boost converter, consisting of a controller (U9) and a rectifier (U8), generates an in-
termediate 7.2 V supply that feeds into an adjustable linear regulator (U5). The feedback network of the lin-
ear regulator is designed such that U5 generates either 3.3 V (with Q3 in the “on” state) or 6.5 V (with Q3
in the “off” state). This supply powers the DUT and the fourth clock buffer (U3). The selection between the
two output voltages is made via the VDUT.PROG.EN signal generated by the micro-controller. D4 is lit when
the higher (programming) voltage is applied to the DUT.

Furthermore, the adjustable linear regulator may be shut down in order to cut off the power supply to the
DUT when VDUT.EN is low (via inverter U4-C). Q2, in conjunction with R34, discharges the bulk decoupling
cap (C14) when the supply is powered down. The power-up/down state of U5 is controlled via the VDUT.EN
signal generated by the micro-controller. D3 indicates whether power is currently supplied to the DUT.

D11 indicates an error condition (overload) of the boost controller. In order to prevent damage to the boost
converter, the USB supply should be removed immediately when such an error occurs. Check the board
and connectors for shorts before proceeding.

Daughter Card Interface Headers

The CS2000 family device must be attached to the motherboard via one of the daughter cards described in
Section 1 on page 4. The desired daughter card plugs into the receptacles J1 and J8 on the motherboard.
Make sure to align the large white triangle on the daughter card with the corresponding triangle on the moth-
erboard before inserting to ensure proper orientation.

10
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3.5

A header (J2) is provided for current measurements. For normal operation, R1 is shorted by a shunt on J2.
If the shunt is removed, the current passes through R1 and a volt meter may be attached to J2. The current
consumed by the CS2000 family device is proportional to the voltage that drops over R1 and can be easily
calculated by dividing the voltage measured on J2 by the resistance of R1 (1 Q).

Clock Inputs

The DUT (depending on the particular variant used) requires up to two clock inputs, REF_CLK and CLK_IN.
Note that the REF_CLK and CLK_IN BNC inputs are terminated with 50 Ohms by R23 and R14.

The CS2000, CS2100, and CS2200 sub-family devices require an external REF_CLK to be supplied and
can all be used with either the -XTL, -OSC, or -CLK daughter cards. The CS2300 sub-family generates
REF_CLK internally and must be used with an -LCO daughter card.

There are several options to generate REF_CLK (see Table 1 and Table 2 on page 4). If a -XTL or -OSC
daughter card is used, REF_CLK is generated on the daughter card by a local crystal or a local oscillator,
respectively.

If a -CLK daughter card is used, REF_CLK will be supplied from the motherboard via the header (J8). On
the motherboard, there are two possible sources for REF_CLK, the right-angled BNC connector (J6) or the
on-board oscillator (Y1). The selection between the two is made via DIP switch position 1, which generates
the OSC.REFCLK.EN signal. U2-C is used as an inverter for OSC.REFCLK.EN _and generates the
BNC.REFCLK.EN signal. If the switch is in the lower (closed) position, OSC.REFCLK.EN is pulled low and
powers up the oscillator via Q1. It also enables the tri-statable buffer U3-C to pass the oscillator output to
the DUT. If the switch is in the upper (open) position, OSC.REFCLK.EN is pulled high (via R61), which pow-
ers down the oscillator and tri-states U3-C. BNC.REFCLK.EN is then low, which enables the tri-statable
buffer U3-B to pass the BNC input from J6 to the DUT. D1 and D2 visually indicate which REF_CLK source
is currently selected via the DIP switch.

CLK_IN is always routed from the BNC connector (J3) to the DUT via a buffer (U2-B) and header J1.
CLK_IN is required for the CS2100 and the CS2300 sub-families. It is optional for the CS2000 sub-family
and not supported on the CS2200 sub-family.

If it is not desirable to buffer the input clocks to the DUT, U2-B may be bypassed by moving the 22 Q resistor
from position R6 to position R5. Likewise, U3-B may be bypassed by moving the 22 Q resistor from position
R26 to position R25.

Clock Outputs

The DUT supports two outputs, CLK_OUT and AUX_OUT.

CLK_OUT is routed from the DUT to the output buffer U4-B via header J1 and on to the BNC connector J7.
AUX_OUT is routed from the DUT to the output buffer U1-B via header J1 and on to the BNC connector J4.

If it is not desirable to buffer the output clocks from the DUT, U4-B may be bypassed by moving the 22 Q
resistor from position R30 to position R27. Likewise, U1-B may be bypassed by moving the 22 Q resistor
from position R8 to position R9.

U4-C and U1-C are used to invert miscellaneous control signals that are needed by other functional blocks.

Micro-Controller

The CDB2000-MB utilizes a SiLabs® 8051-compatible micro-controller with integrated USB PHY for con-
venient interconnect to a PC. The micro-controller comes pre-programmed with custom firmware that allows
it to interact with the CDK2000 Configuration Wizard as well as operate in Stand-Alone mode without a PC.
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If the CDB2000-MB platform is connected to a PC via USB and the CDK2000 Configuration Wizard host
software has established communications with the board, D8 will be lit to indicate micro-controller software
mode. (Note that micro-controller software mode doesn't mean the DUT operates in software mode, which
is entirely independent. It just means that the micro-controller is communicating with the CDK2000 Config-
uration Wizard software on a PC.)

The micro-controller interfaces with other blocks on the board via various logic signals. It receives input from
push-button S1 and DIP switch positions 5 and 6. It also generates various control and status signals.
VDUT.PROG.EN and VDUT.EN control the power supply to the DUT. DUT.PROG.RUN,
DUT.PROG.SUCC, and DUT.PROG.FAIL indicate various status and error conditions via LED D5/6/7.
DUT.HW/SW controls the board-level logic to correspond with the operational mode of the DUT.

DUT Software Mode Control

In software mode, the DUT communicates with the micro-controller via 12C®. The I2C clock and data lines
are routed through Q5/Q7 and Q8/Q4, respectively, which are all “on” when DUT.SW/HW is high (via invert-
er U1-C). D10 is lit to indicate that the DUT is in software mode. (Note that DUT software mode is indepen-
dent of micro-controller software or hardware mode. The DUT automatically enters software mode when it
detects a valid I12C transaction on its control port and must be reset to enter hardware mode. The micro-
controller transitions the board-level logic between hardware and software modes as needed to match the
DUT hardware/software mode.)

Hardware Mode Control

When the DUT is in hardware mode, its operational state is determined by the three mode pins (M2:0). In
this case DIP switch positions 2, 3, and 4 directly connect to the mode pins since Q9/10/11 are “on” due to
the micro-controller driving DUT.HW/SW high, and Q4/5/7/8 are “off” due to DUT.SW/HW being low (via in-
verter U1-C). When a DIP switch is in the lower (closed) position, the corresponding mode pin is logic O;
when a DIP switch is in the upper (open) position, the corresponding mode pin is logic 1 (via pull-up resistors
R52/53/54). D9 is lit to indicate that the DUT is in hardware mode.

4. HARDWARE USAGE AND OPERATION

4.1

41.1

4.1.2

General Considerations

Power Supply

A USB connection is required to power the CDK2000 platform and the DUT. If the board is to be used in
software mode, it must be connected to a PC, either directly or via a self-powered hub. If board operation
in software mode is not required, an alternate USB power supply (such as a wall adapter) may be used
instead. The latter is useful for DUTs that only operate in hardware mode or in a production environment
where multiple DUTSs are to be programmed on an assembly floor and a PC is not available for each work-
station.

Input and Output Clocks

Connect the desired input clock sources as described in Section 3.3 on page 11. If REF_CLK is sourced
from the motherboard (-CLK daughter card option), use DIP switch position 1 to toggle the REF_CLK
source between the BNC connector (J6) and the on-board oscillator (Y1). If REF_CLK is generated locally
(-XTL, -OSC, and -LCO daughter card options), set DIP switch position 1 to the open (BNC) position and
disconnect any external clock sources from J6 in order to minimize clock interferences.

Observe the desired clock outputs on J7 and J4 as described in Section 3.4 on page 11.

12
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4.1.3 Push-Button Operation

44.1

When the board is in hardware mode (USB is powered but the software is not invoked), the on-board
push-button (S1) allows for the invocation of various actions with the board in hardware mode. Pressing
S1 briefly (less than one second) will toggle Vpyt on and off. D3 indicates the current Vp1 enable status.
If Vput is on, briefly pressing S1 twice in a row will reset the DUT. Pressing and holding S1 for more than
a second will initiate the programming sequence (see Section 4.4.1 on page 13), regardless of the power
on/off state of the DUT. If the board is operating in software mode, those actions may only be invoked via
the Configuration Wizard software interface and the board will not respond to any push-button interac-
tions.

Pre-Programmed Devices

Fully pre-programmed DUTSs can only operate in hardware mode. To utilize the CDK2000 platform with the
DUT in hardware mode, use DIP switch positions 2, 3, and 4 to apply the desired logic level to the M2:0 pins
of the DUT. D9 indicates that the DUT is running in hardware mode.

Control Port Devices (-CP)

Control port devices can only operate in software mode. Use a PC running the CDK2000 Configuration Wiz-
ard software to adjust all functional parameters in real-time. D10 indicates that the DUT is running in soft-
ware mode.

One-Time Programmable Devices (-OTP)

One-time programmable devices initially (prior to programming) operate in Preview mode. After program-
ming, they may operate in either Preview or hardware mode. To operate a device in Preview mode, use a
PC running the CS2000 Family Configuration Wizard to adjust the modal and global parameters in real-time.
To operate a device in hardware mode see Section 4.2 on page 13.

Programming -OTP Devices

In order to program a device, a configuration file must first be transferred to the micro-controller via the
configuration wizard. See “One-Time-Programmable Device Evaluation and Programming” on page 8 for
details on how to achieve this. Once a configuration file has been uploaded to the board it is stored in flash
memory and will be retained, even if power is disconnected or lost, and any number of DUTs may be pro-
grammed with this configuration. It is therefore possible to develop and test the configuration file on a PC,
and then transfer the CDK2000 platform into a production environment to program a large quantity of de-
vices without requiring a PC.

Development and Production Modes

Programming the DUT may be done in either Development or Production mode, which are selected via
DIP switch position 5. The difference between the two is how mismatches (if any) between the content of
the configuration file and the content of the pre-programmed OTP in the DUT will be handled. Due to the
architecture and design of the OTP, each bit position can only be transitioned from a ‘0’ to a ‘1’. Once a
‘1’ has been programmed into a particular bit position, it can never be returned to a ‘0’. In addition, certain
bit positions will be locked at the factory such that a transition from ‘0’ to ‘1’ is also prohibited.

In Development mode (DIP switch position 5 in the upper (or open) position), if any violations occur, the
programming sequence will continue and only flag a warning at the end. Programming will proceed on a
best-effort basis; that is, any violations are disregarded (and the affected bit positions left unchanged)
while all other bit positions will be programmed as requested. This mode is most suitable for a prototyping
environment when strict error enforcement of mismatches is not desirable.

DS821DB1 13
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4.4.3

In Production mode (DIP switch position 5 in the lower (or closed) position), if any violations occur, the
programming sequence is terminated immediately (before writing to the OTP on the DUT) and an error
condition will be flagged. This mode is most suitable for a production environment where strict enforce-
ment of mismatches is desired, for instance to detect a situation where a configuration file was designed
for a different base part than what's currently present on the board, and thereby preventing a large batch
of parts from being mis-programmed.

Furthermore, in Development mode, at the end of the programming sequence, the DUT will be reset and
remain in a powered-on state to allow for verification and continued development; whereas in Production
mode, at the end of the programming sequence the DUT will be powered-down to allow for removal from
the socket and insertion of another DUT.

Program Sequence Execution and Result Codes

After a configuration file has been downloaded and the board has been properly configured for either De-
velopment or Production mode, the actual programming sequence may then be initiated via the push-but-
ton (S1) or via the host software (see Section 4.1.3 on page 13 for details). D5 (PROG.RUN) will be lit
while the programming sequence is in progress. During the execution of the programming sequence, D3
(Vput): D4 (Vprog), D9 (DUT.SW), and D10 (DUT.HW) will turn on and off repeatedly as the micro-con-
troller goes through the various steps necessary to program the device. At the end of the programming
sequence, D5 (PROG.RUN), D6 (PROG.SUCCESS), and D7 (PROG.FAIL) will indicate one of several
possible result codes as outlined in Table 3 below.

Error

Code Result/Status D5 (RUN) |D6 (SUCC)| D7 (FAIL)
0 Programming in progress ON OFF OFF
1 Success: no error encountered OFF ON OFF
2 Warning: attempt to clear a ‘1’ in OTP OFF ON FLASH
3 Warning: attempt to set a locked ‘0’ in OTP FLASH ON OFF
4 |Warning: attempt to clear a ‘1’ and set a locked ‘0’ in OTP| FLASH ON FLASH
5 Invalid: no configuration file present FLASH FLASH FLASH
6 Invalid: no DUT found OFF OFF FLASH
7 Invalid: DUT is not a member of the CS2000 family FLASH OFF FLASH
8 Invalid: unsupported revision of CS2000 family device OFF FLASH FLASH
9 Error: register read error FLASH FLASH ON
10 Error: attempt to clear a ‘1’ in OTP OFF FLASH ON
11 Error: attempt to set a locked ‘0’ in OTP FLASH OFF ON
12 Error: attempt to clear a ‘1’ and set a locked ‘0’ in OTP FLASH FLASH ON
13 Error: OTP read-back error OFF OFF ON
14 Error: general or unknown error FLASH FLASH ON

Table 3. Error Codes

The LED pattern for each result code has been carefully designed to convey as much information as pos-
sible without being confusing or overwhelming. In all cases, at most one of the three LEDs will be lit in a
solid on state:

« If the yellow RUN LED is lit solid, programming is in progress, pending results.

e Ifthe green SUCC LED is lit solid, the programming sequence concluded without errors. The other two
status LEDs indicate warnings, if any.

14
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If the red FAIL LED is lit solid, the programming sequence concluded with one or more errors. The oth-
er two status LEDs indicate the nature of the error(s).

If no LED is lit solid and the red FAIL LED is flashing, the micro-controller encountered an invalid con-
dition that must be corrected before proceeding.

Great care has been taken to choose very simple LED patterns for those result codes that are exceedingly
likely to occur in a production environment, that is result codes 0, 1, and 13. All three of these results are
indicated by a single lit LED with the other two status LEDs in the off state. This way, a production floor
operator can quickly glance at the board and immediately classify the result as WAIT, FAIL, or PASS. The
other error codes are either limited to Development mode, setup errors (which would be caught prior to
an operator taking over), or are rather unlikely to occur.

444 Result Code Details

0 (Programming in progress) - This result code really means that programming is not finished, and no
result is available quite yet. The board should only remain in this state for a few seconds. If this condi-
tion persists for more than 20 seconds, the micro-controller should be reset via push-button S2.

1 (Success: no error) - The DUT was programmed successfully and no errors were encountered.

2/3/4 (Warning: OTP configuration violation) - DEVELOPMENT MODE ONLY - One or more OTP con-
figuration violations were encountered, but programming continued on a best-effort basis. The offend-
ing bit positions were left unchanged, while all others were programmed as desired.

5 (Invalid: no configuration file found) - The micro-controller has not received a valid configuration file.
Refer to the software documentation and upload a valid configuration file to the board before proceed-

ing.

6 (Invalid: no DUT found) - The micro-controller was unable to find a DUT on the board. This means
either no DUT is present, or the DUT is defective. Replace the DUT before proceeding.

7 (Invalid: DUT is not a CS2000 family device) - A DUT was found on the board, but it doesn’t appear
to be a CS2000 family device. The CDK2000 platform only supports CS2000 family devices. Replace
the DUT before proceeding.

8 (Invalid: unsupported revision) - The revision of the CS2000 family device found is not supported.
The firmware can only program CS2000 family devices of revision B2 or above. Revisions B1 and be-
low are not supported. Replace the DUT before proceeding.

9 (Error: register read error) - The firmware encountered a register read error. Most likely, this indicates
a defective DUT. You may try to invoke the programming sequence again. If the error persists, replace
the DUT before proceeding.

10/11/12 (Error: OTP configuration violation) - PRODUCTION MODE ONLY - One or more OTP con-
figuration violations were encountered, and the DUT was not programmed. This error indicates either
an invalid configuration file or a configuration file that doesn’t match the DUT variant currently present
on the board. Make sure the configuration file was created for the proper target DUT, and verify the
correct DUT variant is present.

13 (Error: OTP read-back error) - The DUT was programmed, but OTP read-back verification failed.
This error indicates a defective DUT that must be replaced.

14 (Error: general or unknown error) - A miscellaneous error occurred. This could indicate a defective
DUT or a problem with the board hardware or the micro-controller firmware. You may wish to try again,
first with the same and then with a different DUT. If the error still persists, a hardware problem is pos-
sible.

DS821DB1
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5. USER INTERFACE ELEMENTS OVERVIEW

Table 4 below serves as a quick reference to all user interface elements and Table 5 outlines the various DIP switch

position.
Reference | Silkscreen
Designator Label Description
D1 BNC REF_CLK source set to BNC connector
D2 OosC REF_CLK source set to on-board oscillator
D3 VDUT DUT is powered up
D4 VPROG DUT supply set to high (programming) voltage
D5 PROG.RUN Programming sequence in progress (see Section 4.4.3 on page 14 for details)
D6 PROG.SUCC Programming sequence successful (see Section 4.4.3 on page 14 for details)
D7 PROG.FAIL Programming sequence failed (see Section 4.4.3 on page 14 for details)
D8 MICRO.SW Micro-controller is operating in software mode
D9 DUT.HW DUT is operating in hardware mode
D10 DUT.SW DUT is operating in software (control port or preview) mode
D11 EOR Boost converter overload - unplug USB power supply immediately!
D13 USB Board is connected to USB power supply
J1/J8 - Daughter card receptacles
J2 IDUT Place shunt or measure voltage to determine DUT supply current
J3 CLK_IN CLK_IN input for CS2000, CS2100, and CS2300 sub-family devices
J4 CLK_OuT CLK_OUT output
J5 - Input for external control signals (not supported)
J6 REF_CLK REF_CLK input for CS2000, CS2100, and CS2200 sub-family devices
J7 AUX_OUT AUX_OUT output
J9 CDB2000 Interface to CDB2000 (not supported)
J10 USB I/O USB connector
Ji1 Cc2 Header for programming the micro-controller (factory use only)
S1 PROG DUT Initiates various commands (see Section 4.1.3 on page 13 for details)
S2 MICRO RST Reset micro-controller
S3 MODE CTRL Controls various board configuration aspects (see Table 5 below for details)
Y1 - Supports a DIP-8 or DIP-14 canned oscillator
Table 4. User Interface Elements
DIP switch
position Label Switch down (closed) Switch up (open)
1 BNC/OSC On-board OSC active BNC input active
2 MO MO on DUT driven logic ‘low’ MO on DUT driven logic ‘high’
3 M1 M1 on DUT driven logic ‘low’ M1 on DUT driven logic ‘high’
4 M2 M2 on DUT driven logic ‘low’ M2 on DUT driven logic ‘high’
5 PROG.MSEL Production mode active Development mode active
6 MICRO.MSEL Standard operation Reserved (factory use only)

Table 5. Dip Switch Positions

16
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Figure 7. CDB2000-MB Component Map
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Figure 8. CDB2000-MB Top Layer
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Figure 9. CDB2000-MB Inner Layer 1 - Ground

Figure 10. CDB2000-MB Inner Layer 2 - Power
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Figure 11. CDB2000-MB Bottom Layer
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7. CDB2000-DC SCHEMATICS AND LAYOUT

CDK2000
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Figure 12. CDB2000-DC Schematics
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Figure 13. CDB2000-DC Component Map
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Figure 14. CDB2000-DC Top Layer

Figure 15. CDB2000-DC Inner Layer 1 - Ground

Figure 16. CDB2000-DC Inner Layer 2 - Power

Figure 17. CDB2000-DC Bottom Layer
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8. CDB2000-PC SCHEMATICS AND LAYOUT
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Figure 18. CDB2000-PC Schematics
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Figure 19. CDB2000-PC Component Map
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Figure 20. CDB2000-PC Top Layer

Figure 21. CDB2000-PC Inner Layer 1 - Ground

Figure 22. CDB2000-PC Inner Layer 2 - Power
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Figure 23. CDB2000-PC Bottom Layer
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9. ORDERING INFORMATION

Product Description Included Hardware Order #
CS2000-CP 1 x CDB2000-MB
CDK2000-CLK Evaluation & 1 x CDB2000-PC-CLK CDK-2000-CLK
Prototyping Kit 1 x CDB2000-DC-CLK-CP
CS2300-CP 1 x CDB2000-MB
CDK2000-LCO Evaluation & 1 x CDB2000-PC-LCO CDK-2000-LCO
Prototyping Kit 1 x CDB2300-DC-LCO-CP

10.REVISION HISTORY

Release Changes

DB1 Initial Release

Contacting Cirrus Logic Support
For all product questions and inquiries, contact a Cirrus Logic Sales Representative.
To find the one nearest you, go to www.cirrus.com.

IMPORTANT NOTICE

Cirrus Logic, Inc. and its subsidiaries (“Cirrus”) believe that the information contained in this document is accurate and reliable. However, the information is subject
to change without notice and is provided “AS 1S” without warranty of any kind (express or implied). Customers are advised to obtain the latest version of relevant
information to verify, before placing orders, that information being relied on is current and complete. All products are sold subject to the terms and conditions of sale
supplied at the time of order acknowledgment, including those pertaining to warranty, indemnification, and limitation of liability. No responsibility is assumed by Cirrus
for the use of this information, including use of this information as the basis for manufacture or sale of any items, or for infringement of patents or other rights of third
parties. This document is the property of Cirrus and by furnishing this information, Cirrus grants no license, express or implied under any patents, mask work rights,
copyrights, trademarks, trade secrets or other intellectual property rights. Cirrus owns the copyrights associated with the information contained herein and gives con-
sent for copies to be made of the information only for use within your organization with respect to Cirrus integrated circuits or other products of Cirrus. This consent
does not extend to other copying such as copying for general distribution, advertising or promotional purposes, or for creating any work for resale.

CERTAIN APPLICATIONS USING SEMICONDUCTOR PRODUCTS MAY INVOLVE POTENTIAL RISKS OF DEATH, PERSONAL INJURY, OR SEVERE PROP-
ERTY OR ENVIRONMENTAL DAMAGE (“CRITICAL APPLICATIONS"). CIRRUS PRODUCTS ARE NOT DESIGNED, AUTHORIZED OR WARRANTED FOR USE
IN PRODUCTS SURGICALLY IMPLANTED INTO THE BODY, AUTOMOTIVE SAFETY OR SECURITY DEVICES, LIFE SUPPORT PRODUCTS OR OTHER CRIT-
ICAL APPLICATIONS. INCLUSION OF CIRRUS PRODUCTS IN SUCH APPLICATIONS IS UNDERSTOOD TO BE FULLY AT THE CUSTOMER'S RISK AND CIR-
RUS DISCLAIMS AND MAKES NO WARRANTY, EXPRESS, STATUTORY OR IMPLIED, INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR PARTICULAR PURPOSE, WITH REGARD TO ANY CIRRUS PRODUCT THAT IS USED IN SUCH A MANNER. IF THE CUSTOMER OR CUSTOM-
ER'S CUSTOMER USES OR PERMITS THE USE OF CIRRUS PRODUCTS IN CRITICAL APPLICATIONS, CUSTOMER AGREES, BY SUCH USE, TO FULLY
INDEMNIFY CIRRUS, ITS OFFICERS, DIRECTORS, EMPLOYEES, DISTRIBUTORS AND OTHER AGENTS FROM ANY AND ALL LIABILITY, INCLUDING AT-
TORNEYS' FEES AND COSTS, THAT MAY RESULT FROM OR ARISE IN CONNECTION WITH THESE USES.

Cirrus Logic, Cirrus, and the Cirrus Logic logo designs are trademarks of Cirrus Logic, Inc. All other brand and product names in this document may be trademarks
or service marks of their respective owners.

12C is a registered trademark of Philips Semiconductor.
SiLabs is a registered trademark of Silicon Laboratories, Inc.
Windows is a registered trademark of Microsoft Corporation.
Zetex is a trademark of Zetex Semiconductors.
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